
 

Coeus 4.4.3 bugs and quirks list, Updated 5/3/12  
 

This list contains Coeus 4.4.3 quirks, bugs, and FYIs.  It contains all bugs reported in the Coeus Proposal 
Development Guide as well as bugs reported by Coeus users after the last update of that guide. 

CoeusLite Proposal Development quirks are listed at the end of this document. 
 

 

GENERAL COEUS QUIRKS, ISSUES, FYIs  
Summary Description  Last 

update 
Copying proposals If you have trouble copying a proposal, there could be a few reasons why.  If you 

were not an aggregator on the original proposal, it will not let you copy the proposal 
and you will have to ask a coworker who was an aggregator on the original proposal 
to copy it for you and add you as an aggregator to the copy.   
 
If you were an aggregator on the original proposal, there may be a corrupted, 
uploaded file in the narrative of the proposal you’re trying to copy.  If it’s the latter 
case, usually Coeus will let you copy at least the budget.     

10/29/09 

Personnel Names On 4/16/09, the personnel names in all Coeus modules were updated to not include 
special characters (i.e. removing accents from characters).     This will make 
searching for personnel names easier in all modules.  This also helps us with the 
system-to-system Coeus to Grants.gov connection, since special characters cause 
submission issues for Grants.gov.   
 
However, at that time, the PeopleSoft Primary name was pulled in instead of the 
PeopleSoft Preferred name.   As of 5/14/09, the Preferred PeopleSoft name without 
special characters is being used.   

5/27/10 

Printable YNQ  The YNQ are on the Coeus web page as a PDF file and have been updated to match 
the YNQ in Coeus 4.4. 
 

5/27/10 

PI Certification form The PI Certification form is an Adobe fillable form on the Coeus web page.   
 

1/8/09 

Rebooting Coeus 
server 

Coeus production server is rebooted every morning at 5am.  The reboot takes 
approximately 2 minutes, so Coeus will be down for that period of time daily.  

1/16/09 

Locked Proposals 
(locked by your 
account) 

If you try to open your proposal in edit/modify mode, but Coeus won’t let you 
because the “proposal is locked by <your name>”, you can unlock the proposal 
yourself.   

• First, go to the Window menu and see if the proposal is listed at the bottom 
of that list—if it is, then you already have the proposal open and can just 
click on the proposal number in that list to go back to that window.   

• If the proposal is not in the Window menu list, then from the File menu, 
choose “Current Locks”.  You will then see your proposal ID in the list.  
Select the proposal by clicking on it once to highlight it in blue, then click on 
the Delete button.  You will then be able to work on your proposal.  
 

2/12/09 

Locked Proposals 
(locked by someone 
else’s account) 

If you try to open your proposal in edit/modify mode, but Coeus won’t let you 
because the “proposal is locked by <someone else’s name>”, you will have to ask 
that person to unlock the proposal by closing it.  If they do not have Coeus open, you 
can ask the person to unlock it according to the instructions above, or, if that person 
is not available, you can contact the Coeus help desk at 8-7373 and the Coeus 
coordinator can unlock it for you.    

2/12/09 



ARRA Funding For ARRA stimulus funding proposals, please do the following:  
• Add ARRA to the start of the title in the Coeus title field. 
• Enter the Program Number into the "Program No." box in Coeus on the 

Proposal tab screen.  
 

3/30/09 

No Routing Stops 
defined 

If you submit a proposal and get an error message about “no routing stops defined”, 
it means no budget has been entered at all.  If your proposal has no budget, you still 
have to mark the budget of $0 as final and complete.  Then you should be able to 
submit the proposal. 

1/4/10 

Windows 7 or Macs Coeus Premium works on Windows 7 and Macs for viewing data.  Neither has been 
tested for data entry.   
 

8/19/10 

Entering search 
terms 

If you enter a search term (such as a number) on the first line of the search screen 
for the Proposal Development, Institute Proposal, Award and Subcontract modules, 
then want to enter a second number in the next row, in 4.2 you would press the 
down arrows and the cursor would go to the next line.  In 4.4.1 and 4.4.3, the cursor 
stays on the first line with the first press of the down arrow.  You have to press the 
down arrow twice to get the cursor to go to the second line (or use your mouse to 
put the cursor on the next line).  This problem only happens on the first line of the 
search screen. 

5/27/10 

Search results order For the Proposal Development, Institute Proposal, and Subcontract modules:  When 
a search returns more than one search result, the proposals or subcontracts will be 
listed in reverse numerical order, so recent proposals/subcontracts will be listed 
first.  (For the Awards module, the search results order will remain listed in 
numerical order.) 
 

5/27/10 

Notifications There are two notification icons in the Coeus 4.4 Proposal Development toolbar.  
The vendor was supposed to remove the "old" notification icon.  Please do not use 
the old icon to send email.  If you use it, the text of the email will state that an "MIT 
certificate" is needed, which can be ignored. 

5/28/10 

 

s2s submissions  
Summary Description Last 

update 
Organization tab for subaward 
sites  
 

Do NOT press save while on the Organization tab after adding "Other 
Organization" or "Performance Site".  Do NOT click around on the 
screen verifying information you entered.  Instead, click to another tab 
and press save, and print the Performance Site form to verify the 
information is correct.  (If you press save or start clicking around on 
the Organization tab, the congressional districts get severely messed 
up!) 

2/3/11 

Subaward site address Print the Performance Site form to verify the address for the "other 
organization" or "performance site".  Do not trust the address on the 
Organization tab to be the one that prints on the Performance Site 
form 

2/3/11 

TBA types and red baron  While you can load multiple named people into one cost element line 
in the red baron  (i.e. two professors listed in the red baron on one 
cost element line for BPG201), each TBA person needs his/her own 
BPG line.  It's a confirmed Coeus quirk. 

2/3/11 

TBA types and job code in the 
red running guy 

If there is more than one TBA person, and the TBA people are of the 
same "type"(i.e. two graduate students are TBA) make sure to change 
the "Job Code" to be different for each TBA person (i.e. TBA1, TBA2).  
That is the only way Coeus can determine the quantity of TBA people 
of that type.  

2/3/11 

   



Commons name printing multiple 
times on the Senior/Key Person 
form 

There was a case in production where the PI's Commons name 
printed multiple times on the senior/key person form.  The workaround 
was to remove the person's name from the Commons box in the 
Proposal Persons window, save, then add the Commons name back, 
save, and print the form.  The Commons name then printed just once. 

2/3/11 

"Could not append the 
documents listed below" listed in 
the attachment section of a form 
printed from the Grants.gov 
forms tab 

In production we have had cases where the user printed the Research 
Plan from the Grants.gov forms tab, and within the printed PDF, the 
last page said "Could not append the documents listed below:  
ResearchPlan_ResearchStrategy."  One workaround was to delete the 
Research Strategy PDF from the narrative section, then upload the 
Research Strategy PDF again, save, print the Research Plan; the 
other workaround was to do the above but to also rename the PDF 
(i.e. save it under another file name) before uploading it again.  The 
form then printed properly. 

12/8/11 

ValidationException Error when 
trying to print Forms on the 
Grants.gov forms tab 

While on the Grants.gov forms tab, if you try to print the RR SubAward 
Budget form, but do not have a subaward budget attached in the 
budget section, you will get an error message that says 
"org.apache.fop.ValidationException: Error(Unknown location): 
fo:table-body is missing child elements.  Required Content Model: 
marker* (table-row+|table-cell+)."  This means you do not have a 
subaward budget attached in the Coeus budget, Edit menu, SubAward 
budget section.  If your budget does not have a subaward, do not 
select the RR SubAward Budget for printing. 

2/3/11 

"Please attach a Cover Letter" 
error while trying to print forms 
OR only the cover letter prints 
when trying to print forms on the 
Grants.gov forms tab 

Be sure to use the ctrl and/or shift keys to select the forms you want to 
print (the form name row turns blue) and then press print on the 
Grants.gov forms tab screen.  The default on this screen is that Cover 
Letter is selected, so if you press print without selecting other rows, it 
will try to print the Cover Letter.   If it only prints the Cover Letter, you 
need to select the other forms you wish to print before pressing print. 

2/3/11 

"Drools" error at NIH Commons If your proposal errors at the NIH Commons with "drools exception 
error" please have your ORPA rep contact NIH. It means at that point 
in time, the Commons cannot handle the volume of proposals it is 
receiving.  The one time this happened in production, and the error 
corrected itself after the 5pm deadline.  Have your ORPA rep call NIH 
to verify the problem will resolve itself. 

2/3/11 

Printing forms through 
Grants.gov > Forms tab:  the 
narrative attachment is in 
landscape orientation. 

We had an application where the PDF for letters of support contained 
two letters.  When the narrative was viewed in the Coeus narrative 
module, both pages (letters) were in portrait orientation.  However, 
when viewing through Action >Grants.gov > Forms > Print, the second 
page of the PDF was in landscape, while the first was portrait.  When 
it was submitted to Grants.gov and viewed at the commons, both 
pages of the PDF were portrait orientation. 

We asked MIT about this and they said seeing landscape views via 
Grants.gov > Forms >Print means that one of the PDFs is not a 
standard size.  Usually it's a scanned letter that is not conforming to 
the FOP requirements used in the Grants.gov document handling.  
They have seen it happen with foreign A4 paper but also with certain 
letterheads.  

Use the “print to pdf” option for any scanned letters prior to combining 
the files to a single upload.  You might have to rescan all the letters 
and use the "print to pdf" option directly from the scan. 

12/8/11 

Special Note about NIH, human 
subjects pending, and human 
subject assurance number 

If human subjects are involved and you select "pending" on the special 
review screen, then the Human Subject Assurance Number 
information is not transmitted to the NIH Commons, even though the 
Human Subject Assurance Number does appear on the Other Project 
Information form that you print from the Action > Grants.gov forms 
tab.   You will get a warning at the NIH Commons that you will need to 
provide this number at the eRA Commons Just-In-Time (JIT) 
stage.  This is actually an NIH issue as reported in their 1/21/2010 NIH 

2/7/11 



eRA items of interest email and is not a Coeus bug. 

Indirect costs section and 
proposal hierarchy proposals 

If you're doing a proposal hierarchy s2s Grants.gov application, 
sometimes the detailed or modular budget forms do NOT have the 
overhead section filled in, even though you can see the IDC in Coeus.   
If the proposal is submitted as such to the Commons, it *will* error 
out with this error message  that the directs and indirects do not 
equal the total costs.  According to MIT, this bug seems to be 
triggered by syncing the hierarchy from within the  budget screen and 
then clicking save. 
So please be sure to check the Indirect Costs section of your detailed 
or modular budget forms right before you submit the proposal for 
approval. If the indirect costs are not printing, go to the parent 
proposal and sync it from the sync button in the second toolbar 
outside of the budget, and print the budget form again.  The indirect 
costs section should then appear and you can submit the proposal for 
approval. 
 

6/7/2011 

Modular budgets with duplicate 
MTDC lines and incorrect budget 
amounts. 

Issue:  In the modular budget screen, the user presses sync and 
possibly make changes.  Click Ok. Coeus starts adding 2 or more 
MTDC lines and increasing the budget amount in one or all 
periods.  Then when user tries to close and save the budget, a “server 
error: cannot save budget” message  appears. 
 
Solution:  Close the budget screen entirely, say no to saving 
changes.  Close proposal completely.  Search for proposal again and 
press  Edit button.   Open  budget in Modify mode and press save 
immediately (even though you haven’t done anything in the budget 
at this point).  Then go to the Edit menu, Modular Budget.  Press sync, 
make any necessary changes in the MB screen, click OK, mark budget 
final and complete, close budget, reopen budget in view mode and it 
should be fine! 

8/25/2011 

NIH Fellowship: Degree Sought 
During Proposed Award date format 
issue 

When you print the fellowship form through Coeus, the "Expected 
Completion Date (month/year)" prints as YYYY-MM (i.e. 2014-06) 
instead of month/year.  However, you don't need to worry about it 
because when the data is transmitted to NIH Commons, the date 
prints as MM/YYYY (i.e. 06/2014) at NIH Commons. 

5/3/2012 

 
 
 

NARRATIVE FILES  
Summary Description  Last 

update 
Narrative file 
types 

Coeus 4.4 is not limited to word or PDF attachments; it allows other types of files (such as 
Excel) to be uploaded.  However, we recommend uploading PDF files only. 

5/27/10 
 

Uploading 
narrative files 

ORPA is no longer able to upload any files, including the final version of the proposal, to 
Coeus after the proposal has been approved by ORPA, regardless of sponsor.  Therefore, 
please be sure to upload all components of your proposal into Coeus before routing it for 
approval.   

5/27/10 

Review 
narrative files in 
Coeus. 

Please view all uploaded files in Coeus to verify that they can be viewed and are not 
corrupted, before you submit your proposal for approval.  

1/12/09 



Unable to edit 
narrative row  

One user reported that Coeus crashes if she adds a narrative row, but then closes the 
module screen for that row, then uses the Edit button to open the narrative screen for that 
row, and then presses the Upload button.  This happens for any proposal she works on.  If 
this happens to you, the workaround is to add the narrative row, and press the Upload 
button while you are still in the narrative screen.  Then you will be able to upload the 
narrative file without Coeus crashing. 

8/19/10 

mht files can 
only be viewed 
in Premium 

CoeusLite can't handle viewing mht files.  If you upload a mht file, you can only view it in 
Premium and not in Lite. 

5/3/12 

 
 
 

General Proposal Development budget bugs/quirks  
Summary Description  Last 

update 
TBA types and red baron  While you can load multiple named people into one cost element line in 

the red baron  (i.e. two professors listed in the red baron on one cost 
element line for BPG201), each TBA person needs his/her own BPG 
line.  It's a confirmed Coeus quirk. 

2/3/11 

TBA types and job code in the 
red running guy 

If there is more than one TBA person, and the TBA people are of the 
same "type"(i.e. two graduate students are TBA) make sure to change 
the "Job Code" to be different for each TBA person (i.e. TBA1, TBA2).  
That is the only way Coeus can determine the quantity of TBA people of 
that type.  

2/3/11 

Problems with Leap Year 2012 
and the red baron, and budget 
months 

Problem 1:  If you are using the red baron for a graduate student, 
breaking out the academic and summer months, and a subsequent 
year is leap year 2012, when you generate your budget periods, double 
check the red baron in the period containing Feb 2012.  Typically in the 
period that includes February 2012, the end date for the grad student 
in the red baron is 6/29 instead of 6/30.  This leads to the loss of a day's 
salary, and will appear on the Grants.gov form as, for example, 9.97 
months instead of 10 months.    You will have to manually correct the 
end date in the red baron for that period. 
Problem 2:  Also, if you use the red baron for other person types and 
budget academic months, you may see that after generating periods, 
the person's end date may extend one day into the next month (i.e. 6/1 
instead of 5/31) in the budget year containing Feb 2012.  You will have 
to manually correct the end date in the red baron for that period. 
 

2/3/11 
 

The cursor does not stay in the 
same column when pressing 
return  

In Coeus 3.8 you were used to entering a description, quantity, or cost 
on one line, pressing return, and the cursor drops into the description, 
quantity, or cost box on the next line.  This behavior no longer happens 
in Coeus 4.4.  Instead, you will have to either tab your way through 
fields from left to right, or use your cursor to select a line, PAUSE,  then 
click into the field.  If you press return, the cursor appears in the CE box 
on the next line and if you start typing, the numbers will be appended 
to the cost element field.   
If you did start typing into the CE box, when you click or tab out, Coeus 
will let you know you have entered an "invalid cost element" and will 
remove your extraneous typing. 

12/22/08 

Changing costs appends rather 
than overwrites the previous 
cost. 

Click once on the line item to select it, PAUSE, then click once into the 
cost box to change the amount.  If you highlight the amount of money 
with your cursor, do not highlight the dollar sign and the amount.  If 
you do highlight the dollar sign and amount together, any numbers you 

12/22/08 
 



enter will be appended to the current amount instead of overwriting 
the amount.  Avoid this by only highlighting the numbers (or using the 
delete or backspace key) and do not highlight the dollar sign. 

Overhead and/or benefits are 
not calculating correctly (i.e. it’s 
not calculated for every budget 
year or only part of a budget 
year) 

Inside the budget, press the Rates button (it’s on the second toolbar and 
looks like a percent sign).  Press the Sync button.  Then save.  The OH 
should now be calculated.  The most likely cause for this problem is that 
you copied an old proposal or changed the dates on a proposal and did 
not sync the rates. 

5/27/10 
 

Specifying the OH and UR rate 
type 

If you change the OH rate type to something other than MTDC on the 
budget summary tab, please be sure to change the UR rate type on the 
budget summary tab to match the OH rate type chosen.  Depending on 
the scenario, negative underrecovery may be generated, which is fine.  

 

3/5/09 

Negative underrecovery is OK!   When you change the OH rate type to something other than MTDC, 
please change the UR rate type to match.  If you use “MTDC custom” or 
“TDC custom”, and change your rate to something other than the default 
of 0% (in either “MTDC custom” or “TDC custom” in the Rates button), 
Coeus calculates the difference between 0% and whatever rate you 
chose, which generates negative underrecovery.  Negative 
underrecovery is ok!  

4/22/09 

How do I remove positive 
underrecovery?   

First, don’t uncheck the OH or EB rate box for any of your cost 
elements—doing that will generate underrecovery.  Second, when you 
need to change your rate to something other than 61% on MTDC, select 
the OH rate type on the Summary tab as “MTDC –custom” or “TDC –
custom” as necessary.  Change the UR rate type to match. Then in the 
Rates button (on the second toolbar), scroll down until you see the 
“MTDC –custom” or “TDC –custom” (whichever you chose) section.  
Note that there are lines for On and Off campus, for each fiscal year.  
Change the On and/or Off campus from the default of 0 to whatever the 
percentage should be, then save.  You will see negative underrecovery, 
which is fine!) 

4/22/09 

Copying proposals and budgets If you copy a proposal with a budget where the UR rate type is not 
MTDC, in the copy, the UR rate type defaults back to MTDC.  You have 
to change the copy's UR rate type to match the OH rate type.   
 

5/27/10 

“TDC - REU 25%” Rate Type:   The “TDC - REU 25%” rate type only calculates 25% overhead on only 
the cost element that is labeled CE: “STIPEND”, CE Description:  
“Participant Costs – Stipend (no IDC)”.  Even though the element is 
labeled as “no IDC”, it will calculate 25% OH on just that cost element.  

 

4/22/09 

EB calculation differences 
between 4.2 and 4.4 

If the exact same budget is entered in 4.4, the total might be slightly 
different compared to a budget entered in 4.2.  This is because 4.4 
appears to round EB slightly differently than 4.2.   Thus the OH and 
therefore the grand total in 4.4 can also be slightly different than 4.2 
because of this rounding difference.  The difference is generally only a 
penny or two per period. 

5/27/10 

Marking budget as complete with 
cost sharing 

Sometimes when you are trying to mark a budget as complete, Coeus 
tells you that you need to distribute the cost sharing when you actually 
have already distributed the cost sharing.  If the cost sharing values on 
the cost sharing distribution screen are correct, then close the budget 
screen (say no to saving), then click on the budget button and select 
"Complete" from the "Select Budget" screen instead.  Then it should be 
ok. 
 

6/14/10 

Marking budget as final Sometimes Coeus asks multiple times if you are sure you want to mark 
a budget as final.  It should only ask once, but sometimes it asks three, 
five, or even nine times if you are sure.   Just keep clicking yes and 

6/14/10 



eventually it will accept the change. 
 

Graduate student stipend and 
tuition cost elements 

Use BPG209 for graduate student stipend (summer and/or academic 
year) and BPG212 for graduate student tuition. 

8/19/10 

TBA types and red baron  While you can load multiple named people into one cost element line in 
the red baron  (i.e. two professors listed in the red baron on one cost 
element line for BPG201), each TBA person needs his/her own BPG 
line.  It's a confirmed Coeus quirk. 

2/3/11 

TBA types and job code in the 
red running guy 

If there is more than one TBA person, and the TBA people are of the 
same "type"(i.e. two graduate students are TBA) make sure to change 
the "Job Code" to be different for each TBA person (i.e. TBA1, TBA2).  
That is the only way Coeus can determine the quantity of TBA people of 
that type.  

2/3/11 

Pressing the calculate button 
inside the red baron  

If you press the calculate button inside the red baron, instead of it 
showing the calculated values for EB and OH at the bottom of the 
screen, it shows $0 for EB and OH.  This is a bug in 4.4.3.  If you close 
the red baron and then reopen the red baron, the calculated values will 
then appear. 

4/6/11 

 

Budgets periods that are not always 12 months  
(such as 7 budget periods in 5 years) 

 
Description  Last 

update 
• Make sure to adjust budget periods before adding the cost elements and generating.  
 

5/27/10 

• If your budget periods are 12 months and then 6 months, and you enter the 12 month salary for a 
person in the cost box without using the red baron, and then you generate, the 6 month cost for 
that person will not be half of what it was in the first 12 months (plus inflation).  Instead it will be 
4% more of the entire amount entered for the first 12 months.  You will have to manually adjust the 
6 month amount.   

2009 

 
 
 
 
 
 
 
 
 
 

Budget Printing Quirks  
 

Summary Description  Last 
update 

NSF-style budget 
forms 

The NSF-style forms are no longer available for printing. 
During our testing we found the NSF-style forms no longer print our cost elements 
properly.  The NSF-style forms are the forms that were printed outside of the budget 
screen by using the Print button and selecting Generic.  They look like NSF budget 
forms but were labeled “for sponsor use” instead of “for NSF use”. 
The budget forms that can be printed through the budget screen (under File > 
Budget Summary option) are still available and generally print properly if the red 

12/20/10 



baron was used. 
Budget forms in 
general 

Sometimes if a particular category of cost elements has a lot of line items, and these 
line items happen to cross a page break, the program actually prints the total cost for 
that category of cost elements before and after the page break, which is confusing. 

5/27/10 

OH rate and base on 
budget summary by 
period report: 

The OH rate and base is now printed on the Budget Summary by Period report.  
However, the base might be a penny or two off.  The calculated OH will match the 
OH on the Coeus screen. 

5/27/10 

Long titles Long titles are either truncated or run off the budget page. 5/27/10 
Personnel Occasionally, none of the personnel people print on the MIT budget forms.    It is not 

clear as to the conditions under which this happens for budgets created in 4.4. If a 
4.2 budget is printed in 4.4., and the red baron was not used in the 4.2 budget, the 
personnel will not print. 

5/27/10 

Cost sharing 
summary by period 
report 

If you don't use the red baron for a personnel item and that item has cost sharing, 
the cost sharing amount won't appear on the line item for that person on the form, 
and won't be in the cost sharing total nor grand total cost of project for that form.    
 
Sometimes the grand total on the cost sharing summary by period report is a penny 
or two different from the Coeus grand total. 

5/27/10 

 
 
 

 

COST SHARING  
Summary Description  Last 

update 
Distributing 
cost sharing 

In the budget, Edit, Cost Share Distribution window, the “Source Account” can either be 
filled in with the three digit unit number or the 7 digit account number.  Either number will 
print on the Cost Share Report under the Print button, "Cost Share Reports & Generic 
Cover Page" package, PU_CostShareReport.xsl.   If the three digit number or first three 
digits of the 7 digit account number entered in the Cost Share Distribution window are not a 
valid unit number that cost sharing row will not print on the PU_CostShareReport.xsl report.  
 

12/20/10 

Cost sharing 
guidance 

Please remember to appropriately distribute your cost sharing commitments into the 
appropriate units that are providing the cost sharing dollars.  Here is some guidance on non-
departmental commitments: 

• Provost Science Funds (600): This is limited to those Science Fund commitments 
that have been designated in a letter provided by the ORPA Director.  The letter 
must be uploaded into the Coeus Proposal Development module. 

• Dean for Research Funds (680): This is limited to the Research Fund commitments 
that have been designated in a letter provided by the Dean for Research (or in 
combination with the ORPA letter mentioned above).  The letter must be uploaded 
into the Coeus Proposal Development module. 

• University Overhead/F&A (670): This is limited to the calculated F&A overhead 
amount which Coeus may recognize for each applicable cost shared line item.  

5/5/09 

Cost sharing 
in general   

For more information regarding cost sharing, including what to do about overhead, 
please see the Cost Sharing section in the Coeus Proposal Development Guide  

 

4/22/09 

 

PROPOSAL HIERARCHY bugs  
Summary Description Fixed/updated 

http://www.princeton.edu/orpa/coeus/forms/Dept-User-Proposal-Development-4.2-Guide.pdf


Forgetting to add a 
home unit to a 
proposal hierarchy  
 

Please be sure to verify the home and lead unit for each investigator in a 
proposal hierarchy proposal before submitting for approval.  If you forget to 
include a home unit for a child proposal and the parent is rejected, you can try to 
add the home unit to the child, but Coeus won’t sync that additional home unit up 
to the parent.   The workaround is to either copy the parent, add the missing 
home unit to the parent, and submit the copy (which is no longer part of a 
hierarchy) or to copy the child proposals, make the correction in the child 
proposals, create a new parent, sync and submit the new parent proposal.  Either 
way, the original rejected proposal hierarchy will remain in Coeus forever, which 
is fine. 

12/23/09 

 

Quirks and error messages while submitting proposal for approval    
Lock deleted 
by DB Admin 

If you get the "Lock deleted by DB Admin" message when trying to submit, close Coeus, 
reopen Coeus and it should be ok. 

5/27/10 

Narratives are 
incomplete 

If you copy a proposal and then try to submit it, Coeus states the narratives are incomplete, 
even though they are marked as complete.  This is normal behavior; Coeus is basically 
asking you to confirm you really don't want to make changes to the narratives.  However, 
sometimes when you start a brand new proposal from scratch, and you mark all narratives 
as complete, Coeus might tell you that the narratives are incomplete.  You'll go back to the 
narratives section, see they are complete and try to submit again.  Sometimes that is 
enough, but other times it will still continue to state the narrative is incomplete.  We found 
that setting the status of one narrative from complete to incomplete, then changing it back 
to complete and pressing save, seems to resolve this issue and you will be able to submit 

5/27/10 

Budget is 
incomplete 

Sometimes when you try to submit a proposal, Coeus will state that the budget is 
incomplete. You go to the budget and see the budget is actually marked as final and 
complete.  The solution is to change the budget status from complete to incomplete and 
back to complete, and press save.  Then you should be able to submit the proposal. 

5/27/10 

 
 
 
 
 
 
 
 

SUBCONTRACTS  
 
Summary Description  Last 

update 
OnBase URL The URL for OnBase has moved to https://obeprod.princeton.edu/Login.aspx. You’ll only 

need to look up invoices in OnBase if you need to see an invoice that was entered before 
12/22/08.  All invoices from 12/22/08 forward are in Coeus.    
 

1/8/09 

CoeusLite URL 
in subaward 
emails 

The URL for CoeusLite is only in the email for the requisitioner.  As a dept person, if you 
need to see the invoice or details, you can use Premium to look up the invoice.   

1/8/09 

https://obeprod.princeton.edu/Login.aspx


Inbox bug for 
subaward 
invoices 
approvers 
 

If a subaward invoice approver clicks on the checkbox in the Coeus inbox for a particular 
invoice, then presses the "Move Selected Messages" button, it gives a "String index out of 
range -1" message (it should actually display a message about how to approve a 
subcontract invoice).  To approve a subcontract invoice, the approver should click on the 
title or number for the line, which will then take the approver to the screen to select the 
"approve" or "reject" buttons. 
 

12/20/10 

Order of 
subaward 
invoices 
 

The order of subaward invoices on the Amount Released tab is in chronological order.  
This is a change from the 4.4.1 version of Coeus, where the invoices were listed in reverse 
chronological order. 
 

12/20/10 

 

AWARD and AWARD BUDGET BUGS & QUIRKS  
 
Summary Description  Last 

update 
Award rebudget 
"change amount" is  
$-4 or some other 
negative number 

If the change amount for your rebudget should be $0 but Coeus calculates it to be 
$-0, $-4, $-12 or some other negative number, round all values in your change 
amount column to the next highest or lowest dollar amount.  Then your change 
amount should be $0. This particular bug keeps coming back! 

2/3/11 

The “rebudget” button 
is grayed out 

You want to rebudget, but the “rebudget” button is grayed out.  First, make sure the 
last row in the “Budget for Award” screen is highlighted.  (By default, Coeus 
highlights the first line when really it should highlight the last line).  The Rebudget 
should then illuminate.  If it doesn’t, most likely either the last budget hasn’t been 
posted (it's "in progress", "submitted" or "to be posted" status), in which case you 
can't rebudget until  the "in progress", "submitted" or "to be posted" budget has 
posted, or you don’t have rights.  Contact the Coeus Coordinator at 8-7373. 

2/3/11 

“Do you want to save 
changes” while 
viewing an award 
budget 

Please press No if Coeus asks you “do you want to save changes” while viewing 
an award budget (this sometimes, but not always, happens while viewing award 
budgets).  This is a bug, as there are no changes to save because the budget was 
being viewed.  If you press yes and were just viewing the budget, the user name 
and time stamp will change to your name and today’s date.  

5/13/09 

Typing in a new change 
amount appends 
instead of overwriting 
the value 

 When changing values, if you want to overwrite the values that you’ve entered, 
highlight the dollar amount but not the dollar sign.  If you highlight the dollar sign 
and amount, the numbers that you add will be appended to the amount you 
specified. 
 
 

12/22/08 

“Change Amount” 
Total does not seem to 
update itself. 

When you enter a change amount either above or below the line that separates 
most cost elements from the OH and EB cost elements, you have to click into 
another cost element change box either above or below the line in order for the 
calculation to be included in the total change amount box. (If you make a change 
above the line, click into a change amount box above the line.  If you make a 
change below the line, click into a change amount box below the line.)  If you make 
a change above the line, but then click into a cost element change box below the 
line, the change you made above the line will not be reflected in the total change 
amount. 

12/22/08 

Calculate button quirks • If the award is older than approximately 2 years, then the calculate button won't 
work and you'll get an error message about "IDC Rate Information is missing."  
In that case, you will have to calculate OH and EB like you did in 4.2.   

• When the calculate button calculates EB, it calculates based on the start date 
of the award.  If the EB rate has changed between the start date and the 
present date, Coeus will account for that in its calculation, so your calculation 
may be slightly different than Coeus's calculation of benefits. 

• Even if there was no change in EB over the life of the award, the Coeus 

5/27/10 



calculation of benefit might be a dollar or two off.  
• You can type over Coeus's calculated values for OH and EB.   

 
Award summary 
button bug 

The Award Summary button no longer works in this version.  Pressing the Award 
Summary button (or clicking on File > Summary) results in the error message 
"Identifier not found."  You can view Award summary information by clicking on 
Medusa and then clicking on the award number. 

5/27/10 

Award Rights 
 

If a user can view an award, they can automatically view the award budgets now.  
The ability to separate these roles no longer exists in 4.4. 

5/27/10 

Not able to delete a 
rebudget 
 

If the user starts a rebudget and then wants to delete the rebudget, they may see 
an error message stating that they don't have the right to do so.  Please let the 
Coeus coordinator know and she will delete the rebudget for you. 

12/20/10 

Award rebudget status 
 

Sometimes when the user saves and submits a rebudget, the budget window 
closes but the status is displayed as "in progress".  Then when the user opens the 
budget in display mode, the status appears as "submitted".  This is just a screen 
display issue. 
 

12/20/10 

 
 
 
 
 

CoeusLite Proposal Development issues  
 
Summary Description  Last 

update 
Weird error 
message 
after period 
of inactivity 

Your CoeusLite session will become inactivated after a period of inactivity.  However, 
unlike other sites which will log you out after a period of inactivity, CoeusLite will display 
an error message instead that is not comprehensible.  If you leave your CoeusLite session 
open for a while and get an error message when you go back to it, log off of CoeusLite and 
then log back on. 

9/10/10 

Proposal is 
locked by 
your 
account 

If you try to modify a proposal and it says it is locked, click on the "Current Locks" link in 
the upper right corner, then click on each Remove link that you see. This will remove the 
lock on each part of the proposal and then allow you to continue working. 

9/10/10 

Calculating 
person's 
salary 

Let's say you add a person to a CoeusLite budget, and instead of pressing save, you press 
calculate.  CoeusLite then calculates the person's salary.  When you add the next person, 
the calculated value for the previous person disappears, and doesn't reappear until you 
press save.   

This also happens anytime after pressing save and then entering another person's budget 
amount immediately. 

12/20/10 

Modifying 
person's 
base salary 
after 
generating 
periods 

If you modify a person's base salary on the Personnel screen after having Coeus calculate 
the person's salary in periods, you have to go into each period for that person and press 
save on the Personnel Budget screen for EVERY period to get the salaries to recalculate--
the salaries do not appear to be recalculated otherwise. 

9/10/10 

Problem 
trying to 
change 
budget 

This is an intermittent bug.  Sometimes when the user selects Budget Status "Incomplete", 
an error message is displayed that says "An Error Has Occurred: No Message."  If this 
happens, try marking the budget status as Complete from the Budget Versions window.  

9/10/10 



status from 
Incomplete 
to Complete 

This bug does not seem to occur there. 

Problem 
distributing 
cost sharing 

There's an intermittent cost sharing distribution bug in CoeusLite which MIT confirmed is a 
bug.  Sometimes when the user divides cost sharing among several units, CoeusLite says 
the values don't add to the grand total for cost sharing, when they actually do add up.  
Other times it seems to work fine.  If this happens, then Coeus Premium must be used to 
distribute the cost sharing amount. 

9/10/10 

Decimal 
quantity of 
months 
appears as a 
round 
number 

 Anytime there's a decimal quantity of months, it appears as a rounded number.  In this 
example, the number of months should be 2.5 months based on start/end date and 
%charged/%effort, but it appears as 3.0.   At least the detailed Grants.gov budget form lists 
this as 2.5! 

 

12/20/10 

Lite doesn't 
prompt user 
to save after 
syncing 
budget rates 

After syncing the budget rates, Lite doesn't prompt the user to save.  If the user then clicks away from 
the rates screen and continues on with the budget, the old rates are used. This is because the rates 
screen was never saved. Once the user syncs and presses save while on the rates screen, the new 
rates are used. 

12/28/10 

 


